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1 Introduction 

The goniophotometer type Rigo801 is a measuring device for measuring luminous fluxes, 

luminous intensity distributions, and ray data of LEDs, lamps and luminaires. The applied 

near-field measuring principle according to Prof Riemann ([Riem91], [DE297]) allows meas-

urements to be made in the position of use and far within the photometric near-field range.  

   

The measuring installation is set up in such a way that a luminance measuring camera is 

moved at a constant distance around the virtual goniometer center by taking photos of the 

measurement object at many different positions. 

     

The radius of the camera sphere is considerably smaller than the photometric near-field range. 

Nevertheless, the far-field condition is fulfilled because each measurement is composed of 

isolated single measurements of the optical imaging of a measurement object range onto a 

camera pixel, and because each camera pixel covers an object range which is very small in 

relation to the distance of the object. Therefore, the size of the measurement objects is theoret-

ically limited only by the radius of the camera sphere, i.e., by the distance between the camera 

and the center point of the goniometer. Due to the measuring principle, the measurement ob-

ject does not necessarily have to be positioned in the center point of the camera sphere.  

During the measurement, the camera records a four-dimensional luminance field in the vicini-

ty of the measurement object. From this, not only LID curves and luminous fluxes but also 

ray data can be calculated. 
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2 Measuring principle 

2.1 Fundamentals and agreements 

2.1.1 Coordinate systems 

 

 

The above figures show the coordinate system of the goniometer (index G). The  - axis is in 

a vertical position and rotates the outer frame, the  - axis is in a horizontal position and 

moves the inner frame. Besides the goniometer coordinate system, also the camera coordinate 

system, the image coordinate system as well as the C-plane coordinate system are defined.  

The measured ray data are saved in the goniometer coordinate system shown, whereas the 

luminous intensity distribution data are saved in the correspondingly rotated C-plane coordi-

nate system. In the left-hand figure, the C-plane coordinate system is drawn in. Here, the 

gamma coordinates are contra-rotating to the theta coordinates in the goniometer coordinate 

system (y - and z – axis are mirrored). 

The figures below show the camera- and the image coordinate system. However, these are of 

interest to the user only in exceptional cases. 

x, j

y
, 
i

  

2.2 Ray measurement with the camera 

In each luminance image captured, the pixels define vectors in the camera coordinate system, 

i.e., the image coordinates )','( yx , the camera geometry and the knowledge of the optical 

imaging through the camera lens define the vector base point and the direction in relation to 

the optical axis of the camera. 



Software manual RiGO801 

 

 

21.01.2016 TechnoTeam Bildverarbeitung GmbH Ilmenau 6 / 65 
 
 

The knowledge of the camera positions ),,( KKK zyx  and of the „viewing direction“ of the 

camera ),( KK   (direction of the optical axis, usually in the direction of the intersection of 

the goniometer axes) enables the conversion of the directions of the vectors, in the following 

called rays, into the world coordinate system.  

  

The rays are assigned the corresponding luminous flux portions of the luminance pixels by 

multiplying with the solid angle of the pixel and another pixel-dependent quantity (cosine 

weighting). Furthermore, a data reduction of the rays takes place. 

 

Luminance image 

Calculation of the luminous 

flux portions  
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,,,
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Extracted ray data 

The amount of all rays determined in the luminance images captured results in a five-

dimensional data field ),,,,( zyx , called ray data record. In the ray data record measured, 

all photometric information of light radiation is contained. 

At first, the ray data measured exist in a TechnoTeam - format which can be converted to all 

commonly available ray data formats by means of the program Converter801. For detailed 

information the user is referred to the Converter801 manual. 

2.3 Luminous intensity distribution measurement with the camera 

The far-field luminous intensity distribution ),( I  can directly be calculated from the ray 

data obtained. This method is also applied by all common simulation procedures. For this, the 

directions of the rays are discretized, the amplitudes of the rays of each discrete ray direction 

are summed up, and the result is standardized at constant solid angles for each direction. This 

procedure corresponds to the photometric basic formula for the luminous intensity: 
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The figure opposite shows the recording of direc-

tions, starting from different surface elements of 

the measurement object, captured at various cam-

era positions. Thus, a luminous intensity value is 

always composed of data obtained at several cam-

era positions.  

 

2.4 Luminous intensity distribution measurement with the pho-
tometer 

The photometer and the camera are moved together on a spherical surface around the meas-

urement object through the movement of the two axes  and . The measurement of the lu-

minous intensity distribution with the photometer presupposes that the photometer is posi-

tioned beyond the photometric near-field range of the measurement object and that the meas-

urement object is aligned centrally in the goniometer. In this case, the connection between the 

illuminances and the luminous intensities is a device constant which results from the geomet-

rical set-up of the measurement system.  

2.4.1 Photometric near-field range 

Due to a real expansion of the luminaire and the photometer head, a minimum distance be-

tween the luminaire and the photometer head (the so-called photometric near-field range) re-

sults as a function of the luminous intensity distribution and the allowable error. It can be de-

termined by measuring the illuminance as a function of the distance and calculating the lumi-

nous intensity. The photometric near-field range is obtained when the luminous intensity does 

not differ by more than the allowable deviation from the final value. 

In practice, one starts out from the assumption that the error of commonly available meas-

urement objects is negligibly small (< 1 %), if the measurement distance is 15-times larger 

than the biggest luminaire dimension. This error assessment is exactly valid only for Lamber-

tian radiators. The photometric near-field range should be the larger the greater the change of 

the luminance (or also of the luminous intensity) of a luminaire is (e.g. spot radiators, optical 

projection systems). 

In summary, it can be said that the photometric near-field range depends on the following 

factors: 

 the allowable error 

 the largest expansion of the light source 

 the largest expansion of the photosensitive surface of the receiver 

 the direction-dependent luminous intensity distribution of the light source 
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 the local luminous intensity distribution of the light source 

 the direction-dependent evaluation of the radiation by the receiver. 

2.5 Luminous flux measurement with the photometer 

From the illuminance of a single photometer measurement value, the luminous flux portion of 

this value can be calculated by considering the size of the spherical segment to which this 

photometer measurement value applies. For this, the radius of the sphere and also the distance 

to neighboring capture positions have to be taken into account. For obtaining the total lumi-

nous flux –which is of interest – the single partial luminous fluxes must be summed up. The 

luminous flux measurement with the photometer can be made also within the photometric 

near-field range of the measurement object, and is independent of the position of the meas-

urement object. This measuring method of the integration of the illuminances is anchored in 

some fundamental standards ([CIE84], [DIN5032-1]). The corresponding basic photometric 

formula results to: 

   ddsinr  EdA 2

  . 

In the case of the RiGO801 goniophotometers, the luminous flux measurement is always 

based on this measuring method, which is also applied for a camera-based luminous intensity 

distribution measurement. The luminous fluxes integrated by the luminance measuring cam-

era are standardized to the luminous fluxes measured with the photometer, i.e., the camera is 

used as a system making relative measurements only.  
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3 Program start 

The program can be started via the Windows-Start menu (e.g. Start > Programs > Tech-

noTeam > Rigo801). Alternatively, you can also install icons with a corresponding link on the 

desktop which can then be used to start the program by double-click. 

 

During start-up, the necessary calibration data are loaded consecutively, and the hardware 

components of the goniometer, i.e. the camera, the motors and the photometer, are initialized. 

During this phase, an additional window pops up which informs the user of the progress of 

the initialization. This window can either be closed manually or it is closed automatically af-

ter 20s. 

 

During the program initialization phase there are also the connections to integrated external 

measuring devices, e.g. power analyzers, established (see 6.5 and 10.2.5). The configured 

links between measuring device channels and test report fields (e.g. voltage, current, power, 

temperature) are proofed as well. In case of reported errors or inconsistencies the configura-

tion of the related devices needs to be checked in the menu Hardware ->Measure devices. 

3.1 Start configurations 

At the beginning of the initialization phase, the currently set device configuration is queried 

via a dialog. 
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If the goniometer provides an upper and a lower lumi-

naire mount, the currently installed mount must be se-

lected at this point. Later changes of the post configura-

tion require a restart of the RiGO801 program. A wrong 

selection of the start configuration is detected and report-

ed during the initialization of the theta axis. This security 

check is also done while the program is running so that a 

Theta movement with invalid mechanical configuration 

is excluded. 

At this point the required lens can be chosen as well. This can also be done later (see 4) with-

out restarting the program. The adjacent standing maximum DUT diameters are helpful for 

selecting the best suitable lens. When the configuration is confirmed by the Ok button and the 

selection of the lens has been changed a warning message appears regarding a required lens 

calibration procedure (see 4.2). 

3.2 Initialization of the axes 

After having chosen the start configuration, the goniometer axes are initialized. In the case of 

drives with incremental encoders (built until 2011), first the reference positions of the axes 

are searched for (homing), and then the axes are moved into parking position. Goniometers 

with absolute encoders move the axes directly into their parking positions. As the movement 

of the axes represents a danger, the user must first check the safety conditions and then 

acknowledge the following message by pressing the OK button. Please refer to the operation 

manual for details. 
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4 Lens change 

4.1 Lens selection 

Before making a measurement, the best suited lens must be chosen. This can already be done 

when starting the measurement program (see 3.1) or also via the menu item Setup > Changing 

lenses…at any time. 

 

 

The lens which is most appropriate for the cur-

rent measurement object can be selected on the 

basis of the maximum measurement object di-

ameters shown opposite. Fundamentally, always 

that lens should be selected which provides the 

largest image of the measurement object by mak-

ing sure that no elements leave the image during 

measurement. When a new lens is selected, a 

warning message is displayed telling the user 

that a lens calibration is necessary (see below). 

4.2 Lens calibration 

4.2.1 Fundamental principle 

 

 

For calculating the directions of the rays (see 2.2), the exact 

knowledge of the pixel coordinate of the optical axis is required 

(rotation center in the image). This coordinate depends on the 

lens and – due to small position tolerances - changes its position 

whenever the lens is fixed. Therefore, the position of the optical 

axis must be determined again after each lens change.  

The measuring principle is simple. An ordinary lamp or LED is 

positioned in the center of the goniometer, and the camera is ro-

tated by 360° from the viewing direction of the pole. In doing so, 

the alignment light source in the image describes a more or less 

large circle whose center is the wanted pixel coordinate of the 

optical axis. For aligning, a light source with a luminance distri-

bution as homogeneous as possible should be used and whose 

size should neither be too small (< 10 pixels) nor too large (not 

larger than ¼ of the image field). For LED- and lamp goniome-

ters, LEDs with Lambertian radiation characteristic without ex-

changeable optical head are optimum, whereas for big goniome-

ters frosted incandescent lamp or also globe lamps are most ap-

propriate. 

4.2.2 Procedure 

First, the alignment light source must be positioned roughly in the center of the goniometer (< 

50 mm eccentric). If no mount with a suitable length is prepared, also the dialog Align meas-

uring object (see 5) can be used. 
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The lens alignment dialog can be found by selecting the menu item Setup > Lens calibra-

tion…. The dialog consists of the two tabs Adjust camera and Execute adjustment. 

Tab „Adjust camera“ 

 

In the image area of the tab, the current camera image is displayed live. For adjusting, the 

camera must first be moved to the measuring position in the pole using the button Move to 

adjustment position (theta 180° or 0° depending on configuration). Now, the load of the cam-

era must be set to 50% up to 95% (see 6.3). 

After the setting of the camera is finished, the user can switch over to the tab Execute adjust-

ment by mouse click. 

Tab „Execute adjustment“  

While switching over to this tab, the current load is checked and, if necessary, a warning mes-

sage is displayed.  

By pressing the button Start calculation the adjusting movement is started. In the dialog area 

Moving parameter it can be seen at which points images are captured. In the example shown, 

the images are captured at an angle of theta=180° at a distance of deltaPhi=30°. 

At each position, an image is captured and the center of the alignment light source is calculat-

ed, which is then represented both in tabular form and graphically. The points should roughly 

describe a circle.  
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If the alignment light source is inappropriate (too small or too big), or if the size of the light 

source fluctuates too strongly or if the light source is positioned too far away from the center, 

warning messages or error messages will be displayed. In the case of a warning message, the 

user may either terminate or go on with the alignment process. However, in the case of an 

error message (e.g. alignment light source is too small), the lens calibration will be aborted. 

In the dialog area Current correction data , those values are displayed which are currently 

used for correction. In the diagram, this value is marked with a blue square. During the circu-

lar movement, the values are continuously updated in the dialog area Calculated correction 

data or they are marked with a red square in the diagram. The two squares should be nearly 

coincident because the tolerances are usually small. In case of larger deviation it should be 

proofed if the right lens is used and fixed tightly enough. 

 

When the circular movement is complete, a dialog box is 

displayed showing the old and also the new correction fac-

tors. By pressing the button Yes the user can save the data 

and use them until the next lens change. 
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5 Aligning the measurement object 

The dialog for aligning the measurement object is accessed via the menu item Measurement > 

Align measuring object … . 

 

This dialog helps to align the measurement object in the goniometer by means of the camera. 

For facilitating the following evaluation of the measured data it is recommendable to adjust 

the rotation and the tilt of the DUT at this point instead of manipulating the results. However, 

the position of the DUT doesn’t need to be set precisely to the light center according to the 

normative requirements for far-field goniophotometers (see 2 and 6.1). Nevertheless it is rec-

ommendable not to place the luminous areas not too far outside the center because this ex-

tends the moving area of these elements and increases the risk of moving out of the image at 

other positions. Furthermore this also increases the optical flow of the image contents which 

is linked to the best choice of the measuring resolution (see 6.2.3). 

For LID measurements in far-field mode (photometer measurements) of course it is required 

to position the DUT according to the related standards for far-field measurements. If only the 

luminous flux result is of interest the centering of the DUT is not important (see 2.5). 

Another aspect of the alignment procedure comes into account when the ray data results are to 

be used for evaluations in simulation programs. Here the precise position of the ray data cen-

ter in relation to the DUT structure is of major interest for the setup of the simulation. The 

alignment pictures taken from different orthogonal positions are a valuable help for protocol-

ling this center point.  

The image area of the dialog displays the continuously made camera shots. The intersection 

of the yellow lines marks the viewing direction of the camera towards the goniometer center. 
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For a better orientation of the position in the image, some further lines can be drawn in using 

the selection boxes Grid and Circles. The distance between neighboring grid lines can be 

modified by means of the up-down button found below the selection boxes. The selection box 

Metric coordinate system shows a metric coordinate system, which is scaled only linearly in 

the image. Therefore, in the case of wide-angle lenses some inaccuracies may be expected. 

The image brightness can be adapted using the dialog area Integration time, which is de-

scribed in the corresponding section of paragraph 6.3. In contrast to the integration times for 

the measuring mode, time settings up to 500 ms can be made here. 

When using goniophotometers with filter wheel camera, the filter wheel position can be se-

lected in the dialog area Filter wheel filter. This is useful, for example, if you wish to switch 

from VL- over to the glass filter in order to achieve better sensitivity.  

If the goniophotometer is equipped with an incident light illumination unit, this can be 

switched on and off in the dialog area Illumination. Whether incident or back light is better 

suitable for bringing out the relevant structures depends on the DUT (e.g. LED housing or 

glass bulb). 

In most cases, it is necessary to remove the gray filter from the lens and to turn the room 

lighting on in order to be able to fully recognize the measurement object. A logarithmic scal-

ing of the color palette via the pop-up menu View often improves the information content in 

the image. Selecting other color palettes can also be useful. 

The dialog area Axis control contains control elements for the manual positioning of the cam-

era. Different positions of the camera allow the user to check the alignment of the lamp or 

also luminaire on the basis of the live image displayed. Useful are orthogonal viewing direc-

tions. A detailed description of the dialog area can be found in the corresponding section of 

paragraph 6.3. 

If the images of the alignment are relevant for later evaluations, they should be saved using 

the pop-up menu Image . It is advisable to use the BMP image format because this lossless 

format doesn't produce artefacts on the thin lines of the coordinate system as the JPEG format 

does. Furthermore, the dialog area Adjustment pictures clipboard also allows the user to put 

the images into an internal clipboard. Then, after the measurement, the images are attached to 

the TTR file and can be called in all TTR – display dialogs. The advantage is that only one 

measurement file containing all relevant information is necessary. If only the luminance dis-

tribution (*.ttl) is to be saved, this function cannot be used. 

The settings made here are independent of the parameters of the measurement. 
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6 Carrying out a measurement 

 

 

Before making a measurement, the appropriate lens must be 

set (see 4). Also, the a priori alignment of DUT in the goni-

ometer is advantageous (see 5). 

The measuring process is started using the menu item Meas-

urement > Execute measurement…. Thus, the dialog Meas-

uring process is initiated. It contains a list of the steps which 

are necessary for parameterising the measurement. If re-

quired, optional steps can be switched on or also off. A red 

arrow in the left-hand part of the dialog gives information 

about the current list item. 

Each entry in the list is provided with an own dialog, which 

opens automatically after the entries in the preceding dialog 

have been made. 

If one of the sub-dialogs is closed by pressing the button 

Cancel, the user can go back to any preceding list items by 

pressing the button Back in the dialog Measuring process. 

Using the button Continue the user can go on with the pro-

cessing at that point which is marked through the red arrow. 

In the following, the single dialogs are described in the order 

in which they are called. 

6.1 Selecting the measuring method 

 

6.1.1 Dialog area „Measuring method“ 

In the dialog area Measuring method, the user can decide whether the luminance distribution 

shall be measured with the camera (near-field mode) or the photometer (far-field mode). A 

camera measurement is required when the far-field condition (sufficiently long photometric 

distance) is not fulfilled (see 2.4.1) or when ray data shall be measured. Elsewise LID meas-
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urements can also be performed by using the photometer in conventional far-field mode. 

Then, as in the case of a classical far-field goniophotometer, the object must be positioned 

exactly in the center of the goniometer according to the basic standards. 

If only the luminous flux shall be measured, the photometer mode can be chosen regardless of 

the size and the position of the measurement object (see 2.5). The advantage is that the meas-

uring speed is higher as the photometer values are read out at a higher cycle rate and, thus, the 

moving speed of the goniometer axis is higher. 

6.1.2 Dialog area „Result files“ 

In the dialog area Result files, the file names for the measuring results can be entered. The 

luminance distribution is saved in the TechnoTeam file format *.ttl (TechnoTeam luminance 

distribution), whereas the optional ray data are saved in the TechnoTeam *.ttr (TechnoTeam 

Ray) format. The default file name contains the date and the time of the current measurement. 

Using the button Change file name … any desired file name and location can be fixed via the 

file selection dialog. The button Automatic name generates a new file name together with the 

current time. 

The TTL – file contains – in addition to the luminance distribution data – all parameters of the 

measurement, the camera and photometer settings, and monitoring - data. The TTL - format is 

described in great detail in paragraph 11.1 „Luminous intensity distribution *.ttl“ .  

The option of saving the ray data is only available for measurements with the camera. Here, 

using the button Save ray data file the saving of the ray data in a TTR – file can be activated. 

The TTR format can be converted to different standard file formats by means of the Tech-

noTeam - program Converter801. 

6.1.3 Dialog field „LID export“  

In the dialog field LID Export the user may select – by means of the selection box Save addi-

tional LID format – whether the TTL output file shall be additionally saved in another format. 

By pressing the button Settings ... a dialog is opened which contains information about the 

export format chosen. Here, a parameterization of the export format chosen is possible as 

well. Please refer to 10.1.1 for a detailed description of the export formats and their settings. 

6.2 Setting the angular range and measuring resolution 

The angular range and the measuring resolutions are set in the dialog Adjust angular range. 

For optimizing the measuring time it should be ensured to set the angular range of the meas-

urement to the area of the light distribution. Aspects of the best choice of the measuring reso-

lution are explained in section 6.2.3. 

6.2.1 Coordinate system 

All RiGO801 goniophotometer are based on the cartesian coordinate system (x, y, z) centered 

to the goniometer and with the z axis always directing upwards. Thus the theta angle (goni-

ometer arm) starts at the top with 0 degree. In contrast, the 0 degree of a type C coordinate 

system is directed downwards. This difference is to be considered when handling the measur-

ing program. However, the output of the photometric data is done in the type C coordinate 

system. 

Depending on the design of the goniometer, the lamp suspension is provided at the top and/or 

at the bottom. The 0° - position of the theta –axis (goniometer arm) is always at the top for 

both versions. In the case of a goniometer with top lamp suspension, the goniometer arm can 

be moved continuously from 0° to 360° minus the dead angle. A bottom lamp suspension 
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prevents the bottom pole from being run over. For this case, the angular range is fixed at 180° 

to –180° minus the dead angle. 

 

Top lamp suspension 

 

Bottom lamp suspension 

The Cartesian goniometer coordi-

nate system (x, y, z) is identical for 

both versions. The position of the 

axes is of importance for ray con-

version (refer to Converter801 

manual) 

6.2.2 Angular measurement modes 

 

Using the button Whole sphere the com-

plete angular range is set. In this mode the 

theta arm moves from the minimum to the 

maximum angle, thus, because of passing 

the pole, two C-planes are measured dur-

ing one scan. In this mode, only the angle 

resolutions in horizontal (delta phi) and in 

vertical direction (delta theta) are adjusta-

ble. 

Using the buttons Pole cap or also Spher. 

segment the measurement can be limited 

to some certain angular ranges. In these 

cases, compared with the full sphere, 

some further angle parameters can be cho-

sen. 

In pole cap mode it is not allowed to pass any 

pole of the coordinate system (Theta=0° / 

Theta=180°) to prevent double measured an-

gular ranges. 

Pole cap 

 

Spher. segment 

 

In the field Measuring time the time estimated by the program in consideration of the fixed 

angular ranges and resolution for the measurement is displayed. In the case of goniophotome-
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ters equipped with the camera type DX4, the measuring time also depends on the integration 

time chosen of the camera. Thus, the measuring time displayed in this dialog can maximally 

slightly more than doubled, for example, when a current integration time is changed from 1 

ms to 50 ms. The relation between measuring time and angular theta resolution is nonlinear 

for angular steps larger than 1 degree, especially in case of short exposure times of the cam-

era. This is because the frame rate is adapted to the maximum angular speed by skipping 

camera images. 

6.2.3 Choice of measurement resolution and calculating an additional LID 

In the camera measuring mode the angular measuring resolution can be selected in both axes 

between 0.1 ° and 2.5 °. In photometer mode a maximum C or Phi angle increment of 90 ° is 

allowed. Understanding the RiGO801 measuring principle (see 2) facilitates the choice of 

appropriate measurement resolutions in both axial directions. Since this is a digital scanning 

system, the Nyquist-Shannon sampling theorem must be taken into account, which requires at 

least twice the sampling frequency as the maximum existing signal frequency. In case of vio-

lation of the sampling theorem aliasing effects can be expected in the reconstruction of the 

signal. 

Signal frequencies correspond here figuratively the gradients of the three-dimensional light 

intensity distribution and the change of the image content in the adjacent camera images (mo-

tion vectors / optical flow). The sampling frequencies correspond to the angular resolution of 

the two goniometer axes. According to the expected gradients of the LID and expected optical 

flow the appropriate angular resolution must be selected. Unsuitable angular resolutions lead 

to aliasing effects that show up as artifacts in the LID. 

Angular resolution in accordance with the LID gradients 

The criterion of angular resolution based on the LID gradient is clear and corresponds to the 

criterion that applies to classical far-field goniophotometer. A sufficient accurate reconstruc-

tion of distributions with large gradients using individual nodes requires suitably small sam-

pling intervals. This is particularly the case with the radiation characteristic of spots or down-

lights but even with wide radiating luminaires with regions of high gradient. The following 

figures show the LIDs of a linear luminaire with little gradients and of a street light with large 

gradients. In the first case a resolution of 2.5° x 2.5° would be sufficient, in the second case a 

higher resolution, for example 1.5° x 1.5°, is recommended, since larger gradients are present 

in both axial directions. 

  

LID with low gradients LID with high gradients  

For measuring a spotlight with pointed but rotationally symmetrical LID, whose maximum is 

oriented in polar direction, would be, for example, only an increased measurement resolution 

in the scanning direction necessary but not in Phi direction, since there are no large gradients. 
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With some experience you know the expected distributions from the measured object and can 

use this knowledge for the appropriate choice of angular resolutions. In in case of doubt for 

unknown distributions one measures simply with a higher resolution and decides on the basis 

of 3D - representation if the resolution for later measurements can be reduced if necessary. 

Angular resolution corresponding to the change of the image content 

The digital sampling also takes place in the image. The image information of successive im-

ages of a light source is changing (optical flow) and there are more or less large gaps between 

the corresponding areas. Are these gaps too large, it is comparable to using excessive wide 

sampling steps which can lead to aliasing effects. The RiGO 801 measurement program is 

equipped with a smoothing algorithm that reduces these effects but nevertheless it comes to 

artifacts in the LID in certain situations. The following figure shows a measurement with ali-

asing artifacts in the C90-C180 plane. 

 

The effects occur only in the range of the 

C90-C180 plane, so that here apparently 

the change of the image information is too 

large. In this case it is a long and narrow 

light which is vertically located in the im-

age in this area. The outer regions of the 

light here move most, ie, the motion vec-

tors of the outer areas of the image are par-

ticularly long and it comes to larger sam-

pling gaps. The following pictures show 

the camera images of the light at Phi = 0 ° 

and phi = 90 °. 
Aliasing artefacts in around the C90-C180 plane 

 

Luminaire at Phi = 0° 

 

Luminaire at Phi = 90° 

To reduce the sampling gaps the resolution in phi need to be increased, e.g. to 1 degree. In 

this case it’s not relevant to increase also the theta resolution because the gaps are mainly de-

pending on the rotation in phi direction. 

This results in a simple rule of thumb: Measurements of long and narrow light sources 

with higher phi resolution. 

Remaining artefacts, even when using higher angular resolutions, usually disappear after re-

ducing the angular resolution for the final LID file (see following section). 
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Calculation of an additional LID with reduced angular resolution 

Due to the measuring principle of the RiGO801 goniophotometers it is often measured with 

higher resolution than for the later output in the target format of the luminous intensity distri-

bution necessary or customary. A reduction of the resolution can be carried out with the Ri-

GO801 LID export filters (see 6.1.3 and 10.1.1), LumCAT or other programs with which light 

intensity distributions can be edited. 

A high-quality recalculation of a LID in a lower resolution can also be carried out directly on 

the basis of the measured ray data (see 2.3). One solution is to open the TTR ray file with the 

program Konverter801 and recalculate the LID (refer to Konverter801 manual). More con-

venient is the calculation of a separate LID parallel to the measurement by using the option 

Additional LID inside the dialog Adjust angular range. This feature is very convenient espe-

cially for elimination of aliasing effects and also works without additional measuring time 

parallel with the measurement. The result is separate TTL - file with supplemented filename. 

The following figures demonstrate the difference between LID with original resolution con-

taining artefacts and a recalculated LID with lower resolution. 

  

Aliasing artefacts in around the C90-C180 plane Recalculated LID in lower resolution with 
smoothed aliasing effects 

6.2.4 Closing the dialog 

 

When the button Continue is pressed, a safety query is displayed 

asking the user to confirm the parameters set in the dialog. After-

wards, the measurement process is continued. 
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6.3 Setting the camera 

6.3.1 General dialog features 

 

The integration time of the measuring camera remains unchanged during the measurement. 

Thus, an optimal integration time together with a neutral density glass filter for the maximum 

luminance of the test piece must be adjusted before the measurement is started. 

In order to achieve an optimum signal-to-noise ratio just as an optimum exploitation of the 

measuring dynamic range, the dynamic range of the camera image (dialog area Current load) 

should be > 80% for the radiation direction with the highest occurring luminance. In general, 

the measurement can still be made at a maximum dynamic range of 99 %. In this case, how-

ever, it is highly probable that – due to fluctuations of the light sources or even at other posi-

tions with slightly higher luminance maxima – overriding may occur. Therefore, in practice, 

dynamic ranges of larger than 95 % would be avoided. For this purpose, the camera can be 

positioned either manually or semi-automatically in the radiation direction concerned using 

the dialog areas Maximum search in C-plane and Axis control. 

During the display of the dialog, the continuing image capture of the camera remains 

switched on in the image window. The gray scale value palette GV (LSB) arranged to the right 

allows the visual estimation of the image brightness by displaying the connection between the 

actual brightness values and the gray values. Any overdriven regions in the image are marked 

red. 

In the pop-up menu Image the current camera image can be saved or copied into the clip-

board. In the pop-up menu View the display of the camera image can be changed. 

In the single dialog areas on the right-hand side of the dialog, either values are indicated or 

some various operations can be executed. 
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6.3.2 Dialog field „Current load“ 

In the dialog area Current load, the brightness maximum prevailing in the current image re-

lated to the maximum possible gray value is displayed as relative value. When the load is 90 

% or higher, the color of the field with the maximum changes over to yellow, in the case of 

overdriving, it turns red. 

6.3.3 Dialog field „Lens filter“ 

In the dialog field Lens filter, the user must indicate those filters which are currently mounted 

in front of the lens. The correct selection of the filters used is absolutely necessary for lenses 

whose focal length is smaller than or equal to 25 mm as – with decreasing focal length - the 

filters cause increasing additional vignetting in the image (shading), which is corrected using 

the calibration data.  

A single filter can be marked in the list of all available filters via mouse click. If more than 

one filter is mounted, each additional filter can also be marked via Shift- or Ctrl-mouse click. 

If no filter is used, the selection can be undone via Ctrl-mouse click. Thus, no entry is select-

ed. 

Using the list of filters, the transmittance resulting from the filter combination chosen is dis-

played. However, the transmittance does not have an effect on the measurement as the lumi-

nances of the camera are processed as relative measuring parameters and then standardized to 

the luminous flux measured with the photometer (see paragraph 2.5). 

6.3.4 Dialog field „Filter wheel filter“ 

If the goniophotometer is equipped with a filter wheel camera, the filter wheel position can be 

set here. The filter wheel can be provided with neutral density glass filters or with spectral 

filters (color filters, special filters). The use of spectral filters allows the spectral adaptation of 

the camera to be modified according to the filter glasses, for example, to separate the blue and 

the yellow spectral range – in the case of white LEDs – with the filters BG25 and OG530. 

For a standard measurement, however, the V(λ)-filter must be chosen for luminance adapta-

tion. 

6.3.5 Dialog field „Integration time“ 

In the dialog field Integration time, the integration time of the camera 

can be varied between 0.5 ms and 50 ms, either by making an entry 

directly in the input field or by means of the arrow keys. The latter 

allow the times to be varied in pre-defined steps. In the case of a man-

ual input, integration times can be entered with a resolution of 100 µs. 

Using the button Auto one of the pre-defined integration time steps can be selected with max-

imum dynamic range. If necessary, however, the time will have to be adapted using the arrow 

keys or by making an entry directly in the input field. 

If the luminance presents a modulated time curve, the integration time must amount to a 

whole multiple of the periodic length. Otherwise, image flickering would occur which can 

result in extremely noisy LID curve measurement data. For the simple case of an incandescent 

lamp with an operating voltage of 50Hz, for example, a luminous flux modulation of 100 Hz 

will result so that only those integration times lying in a time grid of 10 ms are valid. 

In the case of discharge lamps with magnetic ballast, an intensity modulation of 100 Hz also 

occurs at an operating voltage of 50 Hz. However, the intensity behavior in the second half-

wave may differ from that of the first half-wave, which leads to the fact that - fundamentally 
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speaking – a period of 50 Hz results and, thus, only integration times in a time grid of 20 ms 

are valid for obtaining a stable measuring signal. 

In the case of higher modulation frequencies, the flickering effects can be neglected if some 

periods lie in the integration time. For example, an LED modulated with 400 Hz has a period-

ic length of 2.5 ms so that from about 20 ms on, any integration time can be chosen. In the 

case of luminaires with electronic ballast and considerably higher modulation frequencies in 

the kHz –range, modulation does not have to be taken into consideration on condition that the 

ballast supplies a modulation which is independent of the line frequency. 

In order to facilitate the choice of valid integration times, the selection box Light modulation 

existent can be activated, and the modulation frequency can be entered in the box Frequency 

[Hz]. This function limits the time inputs automatically to multiples of the periodic length.  

In many cases, the radiation direction with the highest occurring luminance (brightness in the 

camera image) is not exactly known. The dialog offers two options for seeking this point: 

Firstly, C-planes can be scanned automatically, and secondly, some single positions in the 

goniometer can be approached manually.  

6.3.6 Dialog field „Maximum search in C-plane“ 

In the dialog field Maximum search in C-plane, complete C-planes can 

be scanned by the camera within the angular range configured for the 

measurement, thus allowing the user to search for the maximum 

brightness in this range. In the selection list available in this dialog field, the desired C-plane 

is selected. After pressing the button Start… , the search is started. When the search is fin-

ished, the goniometer stops at the end of the C-plane. Depending on the measurement result, 

one of the following windows opens: 

 

 

 

If the button Yes is pressed, the goniometer approaches the position found of the maximum. 

Furthermore, the integration time can be varied there, or the goniometer can slightly be 

moved manually around this position in order to possibly find a position nearby (on a neigh-

boring C-plane) with an even higher brightness. If the dynamic range is very small or if there 

is some overdrive at this position, the search for the maximum should be repeated with an 

adapted integration time. 
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6.3.7 Dialog field „Axis control“ 

In the dialog field Axis control, a goniometer position can be entered 

in the two angles Theta and Phi. By pressing the button  the camera 

can be moved to this position. 

In addition, by pressing the buttons  a relative posi-

tioning of the camera is possible. The buttons ,  and  allow a 

manual start-stop operation. By using the buttons  or also , the 

goniometer is moved by -1° or -10° and 1° or 10°, resp. 

 

By means of the manual camera positioning, it is possible – on the one hand – to manually 

search for the brightest point and – on the other hand – to move the camera to an appropriate 

position for changing the neutral glass filters. By pressing the button , the movement of the 

goniometer can also be terminated prematurely. 

The buttons  offer the possibility to approach the pre-defined positions (x-axis: 

=90°, =0°), (y-axis: =90°, =90°), (z-axis: =0°, =0°) and (negative z-axis: =180°, 

=0°). Additional pre-defined positions can be configured when requested. 

6.3.8 Closing the dialog 

 

After pressing the button Continue a security prompt is displayed in 

which the user is requested to confirm the parameters set in the dia-

log. Afterwards, the measurement process is continued. 

6.4 Setting the photometer  

As in the case of the camera, no modification of the measuring range of the photometer is 

made during the measurement. However, the optimum measuring range for the radiation di-

rection with the maximum illuminance must be set. 

 

The dialog field Photometer contains the 

buttons – in a numbered form – for toggling 

between the measuring ranges. Measuring 

range 1 is the most sensitive. The number of 

available ranges depends on the photoelec-

tric current amplifier used.  

The currently measured illuminance is dis-

played next to Measured value, the dynamic 

range in the display Load. 

If the photometer is able to measure also the modulation or also the flicker factor of the light 

source, this is displayed in the text field Flicker factor. In this case, the capacity utilization of 

the photometer refers to the modulation maximum rather than to the average of the 20 ms / 50 

Hz (or also 50 ms / 20 Hz) integration period of the photoelectric current amplifier.  



Software manual RiGO801 

 

 

21.01.2016 TechnoTeam Bildverarbeitung GmbH Ilmenau 26 / 65 
 
 

It is advisable to carry out the selection of the measuring range always at the position of max-

imum illuminance. For this, as for the camera setting, the automatic maximum search can be 

used (see 6.3.6). Before starting the maximum search, however, it is advisable to position the 

photometer approximately in the main radiation direction and to select an appropriate measur-

ing with a load which is not too high. After the maximum scan, the position of the illumi-

nance maximum found is approached, and the measuring range with the highest load of the 

photometer should be chosen. In the case of asymmetrical or also greatly inhomogeneous ra-

diations, the maximum search must be repeated, if necessary, in another C-plane in order to 

reduce the risk of overdrive in other angular ranges. 

 

After pressing the button Continue, a safety prompt is dis-

played in which the user is requested to confirm the parame-

ters set in the dialog. Afterwards, the measurement is contin-

ued. 

6.5 Parameterizing the measuring instruments 

6.5.1 General dialog features 

The RiGO801 software offers the possibility of incorporating external measuring instruments, 

e.g. for detecting electrical parameters or temperatures. This is realized by TechnoTeam Ac-

tiveX device drivers. Before starting each C-plane, the measurement data of the connected 

measuring devices are acquired during the measurement and then saved in the TTL –

measurement file. Additional non-supported measuring devices can be integrated on demand. 

For selected measuring device channels it’s possible to transfer the calculated mean values to 

the corresponding fields of the measuring report. This configuration needs to be done by 

TechnoTeam. 

In the dialog Measure devices, which is displayed at this point of the parameterization se-

quence, all devices incorporated in the process are represented by a tab. 

6.5.2 Tabs of the measuring instruments 

In each tab, there is the option Use by means of which the data acquisition for this measuring 

instrument can be activated during the goniometer measurement. In the case that the instru-

ment is not correctly initialized yet, only the button Setup is active by means of which the 

device-specific set-up dialog can be opened. If the device is available, result fields and the 

designations will be listed in the dialog field Measure values for all detectable measuring pa-

rameters. By pressing the button Select data the user can fix – via a device-specific dialog – 

which measuring values must be acquired. Then, these values will be activated in the list in 

the field Measure values. 

The two figures below show the tabs for the power analyzer type WT210 (Yokogawa) and the 

temperature acquisition with 1-wire sensors (DS1820). 
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Power analyzer type WT210 (Yokogawa) 

 

This figure shows the set-up dialog for the power 

analyzer type WT210. Below the tab COM the 

COM – port to which the device is connected must 

be indicated. By pressing the button Open the con-

nection is made. 

The tab Language contains a list of the available languages. All entries made here are saved 

in the RiGO801 configuration and loaded at the next program start. 

By pressing the button Select data … the dialog for selecting the active measuring values is 

opened. 
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Temperature sensors (1 - wire, DS1820) 

The dialog for choosing the meas-

uring data of the device driver for 

1-wire temperature sensors lists all 

available 1-wire sensors together 

with their ROM-ID. In the column 

Name each sensor can be assigned 

a designation. For this, click on the 

line containing the sensor, change 

the designation in the input field 

Name and finally, click on the but-

ton Apply.  

Using the option Use sensor, the selected sensor is activated for data acquisition or also deac-

tivated. In the column Status, the connection status is displayed just as activation. 

6.6 Measurement details 

6.6.1 General dialog features 

 

In this dialog, nearly all parame-

ters are displayed which will be 

saved later in the luminous in-

tensity distribution file *.ttl. The 

structure of the file format is 

described in detail in paragraph 

11.1.  

The tab Details of measurement 

contains entries marked gray and 

white. The entries marked gray 

are generated automatically by 

the program or also they have 

been entered by the elsewhere 

already. The entries marked 

white can now be processed. 

These entries shall facilitate the 

future work with the results of 

measurement.  



Software manual RiGO801 

 

 

21.01.2016 TechnoTeam Bildverarbeitung GmbH Ilmenau 29 / 65 
 
 

6.6.2 Dialog field „Test lamps“ 

The dialog field Test lamps contains the line Edit with the button 

„...“. If this button is pressed, the dialog Test lamp(s) will be 

opened where the features of the test lamps used in the luminaire 

are edited. For each lamp, a separate tab is displayed where its 

parameters - Type, Number, Power (W) and Luminous flux (lm) – 

can be entered. When making these entries, please note that they 

concern the test lamps rather than lamp settings, i.e., all lamps 

entered are used in the luminaire for the measurement. 

When exporting the files to other file formats for luminous inten-

sity distributions, these test lamps are put together to a lamp set-

ting with the sum of all test lamp currents. In this case, the indication of the type is of im-

portance for the first lamp only. 

The sum of the luminous fluxes of all lamps used results in the Total luminous flux. The total 

luminous flux – together with the luminous flux determined through measurement - is neces-

sary for calculating the efficiency in evaluation programs (e.g. LumCAT). 

In the case of lamp measurements, either the number of lamps shall be 0, or the luminous flux 

of each test lamp entered shall be specified to be 0! Then, the system automatically starts out 

from a lamp measurement with absolute luminous intensities when exporting to other file 

formats or when loading in LumCAT.  

The data concerning the test lamps will be saved in the TTL file only as additional infor-

mation. Furthermore, the calculation of the standardization to cd/klm will start only when 

reading in the TTL-file. Thus, the data do not have any influence on the measurement and can 

be added any time later. 

6.7 Aligning the measurement object 

If the option is activated in the list of measurement sequences, the dialog for aligning the 

measurement object (see 5) is displayed at this point of the setting up of the measurement. 

Here, alignment can possibly be checked again, however, it would always be advisable to 

carry out alignment before the measurement starts.  



Software manual RiGO801 

 

 

21.01.2016 TechnoTeam Bildverarbeitung GmbH Ilmenau 30 / 65 
 
 

6.8 Starting the measurement 

 

After having done all necessary preparatory work 

and after having made all entries, the dialog Exe-

cute measurement is opened. It remains visible dur-

ing the whole measurement and gives information 

about the stage of processing.  

Before pressing the Start button one selects the 

startup mode Delay until start [h:min:sec] or the 

automatic start after the stabilization procedure (see 

6.9) with Monitor lamp during burn-in. 

The selection box Record illuminance at the pole 

activates the monitoring of the illuminances at the 

pole during the measurement. The data are saved in 

the TTL-file and shown in the form of a diagram 

and table in the results display. Thus, it is possible 

for the user to evaluate the stability of the light 

source during the measurement. This function only 

makes sense when there is some radiation towards 

the pole, and when the illuminance distribution is 

not too inhomogeneous. 

The selection boxes Continue in case of camera / photometer overload and Log overloads in 

file(s) change the standard reaction in case of overloads. It's usually advisable to enable these 

options so that the measurement continues, the positions of overload are logged and a warning 

is given only at the end of the measurement. 

The corresponding protocol files can be found under the names „[Measurement 

file]_overflow_cam.txt“ or also „[Measurement file]_overflow_pe.txt“ in the same directory 

of the measurement files. The camera log file contains the columns phi, theta and number ob 

overloaded pixels for each overloaded image. The photometer log file only contains the col-

umns phi and theta. If the number of overloads in relation to the number of measuring posi-

tions is very small, the impact should be negligible. 

In den fields Current phi or also Current theta, the current position of the goniometer is 

shown. After starting the measurement by pressing the button Start, the fields Start of Meas-

urement and End of Measurement will be filled out by the program. The progress bar allows 

the user to estimate the portion of the captures already taken in comparison to the whole 

measurement. 

Using the button Cancel a measurement can be terminated prematurely. In this case, it will 

not be stopped immediately but only after the end of the current C-plane. The button ”Can-

cel“ cannot be used as EMERGENCY STOP! 
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6.9 Stabilizing procedure 

6.9.1 General dialog features 

 

Using the function Burn-in lamp the program can be made to start a measurement automati-

cally when the luminous flux of the DUT has reached a stability criterion. The dialog Burn-in 

lamp is opened when the user has selected the option Monitor lamp during burn-in in the dia-

log Execute measurement. In this case, the luminous flux of the lamp is monitored indirectly 

via the illuminance measured with the photometer. For this purpose, the photometer should be 

brought to a position of the measurement object with sufficient illuminance. In most cases, 

this condition is fulfilled when the last adjustment step was the setting of the photometer (see 

6.4). Otherwise, the photometer can be positioned accordingly in the dialog field Axis control. 

The stability value is the ratio between the minimum and the maximum illuminance occurring 

within one time interval. The aim is to obtain stability criteria over a longer time period as the 

light source must remain stable for the whole duration of the measurement. Thus, only those 

time intervals which are of an appropriate length are beneficial, for example 15 minutes. The 

values of the stability criterion are usually in the range from 0.2% to 0.5%. 

After starting the process by pressing the button Start, illuminances are continuously meas-

ured and drawn in the diagram (left-hand Y – axis). Only after the time interval boundary is 

reached, the first error value can be calculated, and the error axis is displayed in the diagram 

(right-hand Y-axis). Now, the error values are continuously determined – in each case for the 

previous time interval - and then drawn in the diagram in the form of an error curve. From the 

time entered in the field Minimum burn-in time [h:min] on, the measurement starts automati-

cally when the error has dropped below the stability criterion threshold. If, however, the 

threshold has not been reached by the time entered in the field Maximum burn-in time 

[h:min], the measurement will start nevertheless provided that the corresponding option is 

selected in the dialog field Final measurement. 
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During the stabilization phase the data of the external coupled devices (see 6.5) are acquired 

as well and shown as table in the tab sheet Measuring devices. In case a power analyzer is 

available the option Burn-in according to IES LM-79-8 gets available. This option fixes in 

accordance to this standard the minimum stabilization time to 30 minutes, the length of the 

time interval to 15 minutes and the maximum of the stability criterion to 0.5%. Additional to 

the illuminance also the electrical power is acquired and rated with the stability criterion. The 

graph is presented in the Power tab sheet. 

 

Trend of the power during stabilization phase 

The data of the stabilization process will be saved in the TTL – file if the option Save data to 

measuring file is selected (default). All data are visualized in the result file. The data just as 

the diagram graphics can also be saved in separate files if file names are entered in the dia-

gram field Save data and graphic separately. 

Using the button Cancel monitoring can be terminated prematurely, and the measurement can 

immediately be started if the user wants to do so. 

6.10 End of measurement and displaying the measurement results 

After each measurement, the measurement results are displayed in a dialog. This dialog is 

described in paragraph 7. If overloads occur during the measurement, a corresponding warn-

ing message is displayed. In this case it is recommended to analyze the logged files (see 6.8). 
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7 Display of measurement results 

7.1 General dialog features 

The dialog for displaying the measurement results is available in all RiGO programs (Ri-

GO801, Converter801 and 3D-Viewer). All relevant data of the TTL measuring file are visu-

alized, and, in the case of a TTR ray file, also information on the ray data is displayed. 

The subordinate data displays are represented in tab windows. In the lower dialog area, the 

button Load is provided which allows another measuring file to be loaded (TTL or TTR). The 

file can then be saved using the button Save as … (e.g. after changing the measuring lamps). 

7.2 Tab „Details of measurement " 

The tab Details of measurement is already described in paragraph 6.6 with respect to the set-

ting up of a measurement. After the measurement, in the area Lid the luminous flux measured 

is entered in the field Luminous flux. Furthermore, under Light output ratio, the operating 

efficiency based on the luminous flux of the test lamp and on the luminous flux measured is 

entered. 

 

7.3 Tab „Lid graph“ 

The tab Lid graph shows a polar diagram of the luminous intensity distribution. In the combo 

boxes on the right, the C-planes to be displayed can be chosen. The pre-defined colors can be 

changed to the color ranges by a mouse click. 

Using the button Print a printout of the graphic on the default printer currently set in the oper-

ating system can be obtained. The representation will then be identical to what is displayed on 

the screen at this moment. The default printer can be changed by pressing the button Print-

er…. 
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Using the selection box Standardization cd / klm the user can select whether the absolute val-

ues measured of the luminous intensity are displayed or whether the luminous intensity is 

displayed in a form standardized to a lamp luminous flux of 1000 lm. 

 

7.4 Tab „Lid table“ 
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On the tab Lid table the measurement values of the single C-planes are displayed in tabular 

form. By pressing the left-hand mouse button and dragging the mouse pointer or also via the 

context menu (right-hand mouse button), a well-defined data area of the table can be marked. 

Via the context menu entry Copy the data area marked can be copied into the clipboard of the 

operating system. 

Using the selection box Standardization cd / klm the user can select whether the absolute val-

ues measured of the luminous intensity are displayed or whether the luminous intensity is 

displayed standardized to a lamp luminous flux of 1000 lm. 

7.5 Tab „Rays of camera images“ 

 

If the user has decided to save the ray data (see 6.1.2), the tab Rays of camera images is added 

to the dialog. The slider provided on the right allows the user to select any capture of the data 

record. The appertaining recording parameters are shown in the display fields on the left. In 

particular, the position of the camera at the moment of image capture can clearly be seen (text 

fields Theta and Phi). 

7.6 Tab „Measuring devices“ 

If measurement values supplied by incorporated measuring instruments have been logged 

during the measurement (see 6.5), these data can be found on the tab ActiveX-Sensors. For 

each instrument, a subordinate tab is available. The data are displayed in a table. Each line 

contains those values measured before starting the respective C-plane. 

Data exchange with external programs can be realized via the clipboard. In the context menu 

of the right-hand mouse button, the user finds all functions for marking table areas as well as 

exporting data to a file. The usual key combinations to carry out these actions are available, 

too.  
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7.7 Tab „Burn-in data“ 

 

If the measurement has been started automatically with the function Burn-in lamp (see 6.5), 

the data logged during the stabilization phase can be viewed on this tab. 

Via the context menu of the diagram (right-hand mouse button), the diagram can be saved as 

image file, or the underlying data are saved as an ASCII file. 
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7.8 Tabs “Pole-monitoring-Graphic” and “Pole-monitoring-Table” 

The logging function Pole monitoring being activated (see 6.8), the illuminances of the pole 

for each C-plane are contained in the TTL file. These tabs, Pole monitoring graph and Pole 

monitoring table, visualize these data in the form of a diagram or a table. Via the context 

menus of the diagram and the table, the graphic or also the data can be saved or exported into 

the clipboard. 
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8 Measuring projects 

In addition to the functionality of single measurements described in Chapter 6 is possible to 

run measurement projects with multiple measurements. So, for example multi-channel meas-

urements with different color filters (optional filter wheel / color camera) can be carried out 

conveniently. For goniophotometers that are equipped with a color measuring camera (filter 

wheel), this program module is enabled by default. On demand the module can be enabled for 

other applications. 

8.1 Measuring project editor 

Using the measuring project editor (menu File -> Measuring project – editor …) a measure-

ment project is created. At the start of the editor a dialog opens that contains the two tabs 

General and Measurements. The general specifications are nearly identical to those of the 

individual measurements (see 6.6). 

 

At the top of the tab Measurements the list of measurements is shown and at the bottom are 

the dialogs for configuring the selected entry. A new list entry is created with the button New 

or via the context menu of the right mouse button. Using the tabs Measuring method, Angular 

range, Camera and Photometer the measurement can be set up according to section 6. 

New list entries are created as a copy of the currently selected entry. If one wants to make, for 

example, measurements with different filter positions, the first measurement is set up com-

pletely and based on this settings the following measurements are derived. Only the affected 

parameters are changed in the tab Camera. 
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8.1.1 Measuring method 

As additional option this tab provides the storage of saturation data of the camera and pho-

tometer for all sensor positions in separate files. When required, the measuring project navi-

gator (see 8.3) can display this saturation data in form of images to have a detailed overview 

about the sensor saturations. 

 

8.1.2 Angular range 

In contrast to the single measurement 

settings dialog, the option Record illu-

mination at the pole (see 6.8) is already 

defined at this place. 

 

8.1.3 Camera 

The parameterization of the camera is handled in detail in section 6.3. The following figure 

shows the camera settings for the first measurement with selected V(λ) filter. The measure-
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ment list view shows that the following measurements are set to filter X1 and X2 with indi-

vidual integration times. 

 

8.1.4 Photometer 

The setup of the pho-

tometer is described in 

section 6.4. 

 

8.1.5 Storage 

In contrast to single measurements measuring projects are stored in a special directory defined 

by the configuration (e.g. d:\measurements\projects). Each project gets its own directory and 

all project parameters are saved in the file project.prj. When saving a new project by choosing 

Project -> Save as … the dialog New measurement project opens which contains the list of 

existing projects and the button Change ... for selecting a new name. 
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The project name input dialog only allows characters that 

don’t interfere with the valid file system characters be-

cause this name is also used as the project directory name. 

 

 

8.2 Carry out a measuring project 

The menu Measurement -> Execute measuring project … opens the following dialog. In this 

example a project has already been loaded by using the menu item Project -> Open …. 
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The column Active indicates whether a measurement is to 

be performed or not. This status can be changed by double-

clicking or using the context menu of the right mouse but-

ton. The column Finished shows whether the measure has 

already been executed and measured data are available. 

 
 

If an already completed measurement is reselected for execution, a warning appears that the 

existing data will be deleted when the measurement starts. 

In the same way as a single measurement the measuring project can be started delayed or au-

tomatically after a stabilization phase (see 6.8). The behavior in case of saturation/overload 

can also be specified here. Overloads are in contrast to the single measurement recorded in the 

general log file of each measurement (see below). 

The measuring process is started with Measurement -> Start. 

 

The status of the current measurement is displayed in the area Current measurement and in-

formation about the total progress including an estimated measuring time is given under 

Measurements. 

The filenames of the measurements are automatically generated and are composed of a con-

tinuous measuring number, the measurement resolution and the filter wheel position (e.g. 

M26_cam_cap_0_500x0_500_VL.ttr). For each measurement a log file with the extension 
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_LOG.TXT is created. In addition to general information about the start and end of measuring 

the log files contain positions of overloads and if errors occur, the complete error report. 

Detail of a log file with overload messages: 

[201302271403]: Project: D:\Measurements\Projects\G\project.prj 

[201302271403]: Filename: M27_cam_cap_0_500x0_500_BG25 

[201302271403]: Measure started 

[201302271403]: Overflow Camera (Theta -4.712414e+00, Phi 0.000000e+00) 

[201302271403]: Overflow Camera (Theta 2.855948e+00, Phi 0.000000e+00) 

[201302271403]: Overflow Camera (Theta 1.395580e+01, Phi 0.000000e+00) 

… 

8.3 Measuring project navigator 

The measuring files of a project can be opened directly by using the File -> Open … menu of 

the RiGO801 measuring program or the Converter801 or they can be explored by using the 

special measuring project navigator with File -> Measuring project – navigator …. The navi-

gator displays a tree view of the projects with their belonging measurements. The results of 

the selected measurement are displayed in the usual way in the right pane. Additionally the 

result view of the navigator offers the tab Logfile. 
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9 Spectrometer extension module 

9.1 General 

The spectrometer extension module embeds the functionality of spectrometer measurements 

in the RiGO801 software. This module allows spectrometer measurements to be carried out 

manually or automatically as sequence of single measurements on the basis of a list of posi-

tions. Part of the evaluation is the calculation of the mean spectral power distribution (SPD) 

and derived values (e.g. color coordinates, CRI) according to LM79 and ED 13032-4. 

9.2 Manual spectrometer measurement 

The menu item Hardware > Spectrometer... opens the dialog for the manual spectrometer 

measurement. In the right-hand part, the spectrometer dialog offers some options for the pa-

rameterization of the spectrometer. The left-hand part of the dialog can be used for represent-

ing the measured spectra in a diagram. 

 

9.2.1 Parameterization 

All settings necessary for a spectrometer measurement 

can be made in the measurement parameter dialog 

(menu item Measurement > Settings…). Some im-

portant settings and also the dark signal correction 

option (depending on the type of spectrometer) are 

additionally available in the right-hand part of the 

main dialog. 
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Setting of the integration time 

The integration time of the spectrometer is set in the group box Integration time. Using the 

button Automatic before measurement the user can fix the integration time to be determined 

automatically through a series of trial measurements immediately before the actual measure-

ment. The saturation degree of the measurement made last is visualized by the saturation indi-

cation Current load. In case of lower saturation levels (< 30%) it is useful to activate the av-

eraging function. 

Smoothing of the measuring values 

The measuring values of each spectrometer measurement can be smoothed by averaging. In 

the group box Average averaging can be activated (option Active), and the intensity of 

smoothing can be parameterized through the number of the partial measurements applied (edit 

field Number). 

Settings of the spectral range 

The settings of the spectral range can be made in the dialog for the measuring parameters 

(menu item Measurement > Settings…). In the section Spectral range, the user can fix both 

the wavelength range (entries Start wave length [nm] and End wave length [nm]) and the 

spectral resolution (entry Resolution [nm]).  

If the spectrometer does not support variable measuring range and resolution settings, the 

spectrum will be determined with the help of the device parameters, and resolution will be 

reduced numerically. If the device resolution amounts to a multiple of the desired output reso-

lution, an appropriate low-pass filter will be applied before the spectral values are calculated 

by linear interpolation at the desired wavelengths from the spectrum measured. 

Spectrometer device parameters 

Using the menu item Spectrometer > Device set-

tings… a dialog containing device-specific parame-

ters can be opened. The parameter regarding the 

wavelength calibration and the linearity and dark 

signal correction are not relevant for the JETI spec-

trometer devices used for the RiGO801 goniopho-

tometers. 

 

Spectrometer calibration 

This dialog is not relevant for the used JETI spectrometer devices because the calibration is 

included in the spectrometer. 
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9.2.2 Do measurements 

Single measurements can be made using the button of the tool bar  or the menu item Meas-

urement > Single measurement.  

The tool bar button  or the menu item Measurement > Live activates or deactivates the con-

tinuous measuring mode. 

9.2.3 Measuring results 

The graph of the spectral data displayed in the context menu offers various options of data 

representation. By pressing the left-hand mouse button, the user may select a certain range 

which allows the enlargement of the data range shown. Enlarged data ranges can be shifted by 

pressing the right-hand mouse button. An enlarged representation can be reset via the context 

menu entry Display > Reset zoom. The default settings of the display can be restored using 

the context menu item Display > Default.  

In the status bar of the dialog several calculated values are displayed (xy chromaticity values, 

color temperature, color saturation, dominant wavelength, color rendering indices). 

The result of a measurement can be saved in the *.tsd-, *.csv- or *.isd-format using the menu 

item File > Save as…. 

The file format *.tsd (Technoteam Spectral Data) is a binary format in which all relevant de-

vice parameters and settings are saved in the header. The format allows several measurements 

to be saved. For this, it must be made sure that the header information is compatible. Any 

incompatibility can be caused by modified parameters of the spectral range (e.g. resolution) or 

different additional information.  

The file format *.isd (Instrument Systems Data) is a ASCII character format for spectral data, 

developed by the company Instrument Systems. 

If an existing file is selected for being saved, the user will be 

requested whether the measurement shall be attached or 

whether the file shall be overwritten 

 

Using the menu item File > Convert file… the tsd-file format can be converted into the *.csv-

format, which can be read by Excel (csv - comma-separated values) or the *.isd-format. For 

this, first the tsd-source file is selected, and then the csv- or isd-target file. To the csv-file all 

information contained in the tsd-file will be given out in a hierarchically structured way (see 

9.3.6). 

9.3 Position controlled measuring sequence 

9.3.1 Measurement process 

The parameterization of the spectrometer and the measuring sequence, the carrying out of the 

measuring sequence as well as the visualization of the results take place on the basis of a dia-

log via the menu item Measurement > Spectrometer measurement... of the goniometer soft-

ware. In the dialog of the spectrometer measurement, the single steps of the parameterization 

and of the execution of a measuring sequence are summarized in the form of tab pages. 

The generation and the management of the spectrometer positions can be effected via the tab 

Positions. The parameterization of the spectrometer or also of the single measurements is car-

ried out in the tab Spectrometer. The tab Measurement is used for the parameterization and 
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execution of the measurement. Then, the results of a measuring sequence are shown in the tab 

Results. 

9.3.2 Generation of the list of positions 

For each measuring sequence, a list of positions must be established. This list contains the φ-

θ-positions of the single measurements of the spectrometer measurement. The positions are 

generated via one of the two tabs Phi-Theta-Grid or Manual arranged in the left-hand part of 

the dialog. The right-hand half of the dialog shows the list of the positions generated. 

 

Single positions marked in the list can be edited using the buttons , , Delete 

and Delete all . By pressing the button  , the spectrometer is moved to the desired 

position. The current list of positions can be saved using the buttons Save as … and Load … 

in the form of various formats, and it can also be reloaded again later. 

Below the item list it is stated whether the list is compliant with the standard LM-79-08 or 

not. In the above case, the maximum increment in theta exceeds 10 degrees and thus the posi-

tions are not compliant. In case of conformity to LM-79-08 the middle spectrum and the de-

rived parameters are calculated and stored in the CSV file (see 9.3.6). 

Phi-Theta-grid 

The tab Phi-Theta-Grid is used to generate a group of positions. These are arranged in a φ-θ-

grid of the spherical coordinate system of the goniometer. In order to keep the measuring time 

short, the positions are arranged in theta-direction in a meander-shaped way. Analogous to the 

dialog Adjust angular range of a goniometer measurement (see 6.2), it is possible – depend-

ing on the selected traversing regime (Full sphere, Polar cup or Segment) – to adjust the 

tracking limits (Minimum phi [°], Maximum phi [°], Minimum theta [°] and Maximum theta 

[°]) as well as the resolution of the grid (Delta phi [°], Delta theta [°]). For LM-79-08 com-

pliant position lists the increment in Theta must not exceed 10 degrees. 
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Single positions 

 

The function of the tab Manual is to generate some single po-

sitions and to approach spectrometer positions for trial meas-

urements. In the group box Position, coordinates can be de-

fined and added to the list of positions using the buttons Insert 

or also Replace. 

The button  is used to insert the currently selected posi-

tion list entry in the coordinate fields of the group box Posi-

tion. The operating elements contained in the group box Axis 

control allow the user to approach goniometer positions man-

ually for testing purposes. 

Analogous to the group box Position, the positions of the axes can be added to the list of posi-

tions. Furthermore, it is possible to adopt a position of the list of positions as axis position and 

to move the spectrometer into the desired position. 

Estimation of the measuring duration 

From the travelling times which result when approaching the measuring positions, and from 

the integration time chosen, the duration of the measuring sequence is estimated and dis-

played in the main dialog (position at the bottom left). The estimated measuring duration is 

displayed only when one of the tabs Positions or Spectrometer is active. 

9.3.3 Parameterization of the spectrometer 

The dialog of the tab Spectrometer enables the user to parameterize the spectrometer hard-

ware. Except for the menu bar, which is not available here, this dialog corresponds to that of 

the manual measuring value recording (see 9.2). 

 

Basically the option Automatic before measurement can be activated to adjust the integration 

time to the position dependent irradiance prior each measurement. However, this results to 

long measurement times in areas with low irradiance (maximum integration time 60s) and to 

unpredictable total measuring times. Alternatively, the setting of a fixed integration time in 

the maximum of the distribution and an averaging of for example 5 or 10 measurements per 
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position is recommended. Carrying out the spectrometer measurement after a LID measure-

ment, the position of the maximum can be taken from the measurement protocol (section 

LID) and be used for setting the integration time at this position. 

9.3.4 Spectrometer measurement 

The function of the tab Measurement is to assist the parameterization and execution of the 

measuring sequence. In the upper group box Measurement control, the name of the target file 

(group box Measurement file), the program behavior in the case of overloads (group box Ac-

tion on overload), and an optional waiting or stabilization before starting the measurement 

(group box Action on start) can be fixed. The lower group box Measurement is used for exe-

cuting and controlling the measurement.  

The measuring data are saved in the TechnoTeam-format for spectral data *.tsd, and addition-

ally exported in the *.csv – format (csv - Comma-Separated Values) or the *.isd – format. 

After each measurement, the spectral data are displayed in the tab Results. 

 

Name of the result file 

The name of the measurement file can be fixed either on the basis of the dialog by pressing 

the button Change filename … or automatically by pressing the button Generate name. If the 

file name is generated automatically, this is done on the basis of the current measuring time 

(e.g. 2011-04-04, 10:48  201104041048.tsd). 

Starting action 

In the group box Action on start , the stating conditions are defined. When the option Delay 

until start is activated, the waiting time entered there is kept. If the option Monitor lamp dur-

ing burn in is active, the measurement starts when a stable operating condition is reached (see 

6.9). 
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Behavior in the case of overload 

In the group box Action on overload, the actions carried out by the program in the case of 

overloaded measuring values during the spectrometer measurement are fixed. 

If the option Continue in case of Overload is activated, the 

measurement will be continued without any warning message in 

the case of overloads. If, however, this option is not active, a 

warning message will be displayed, and the user will be asked 

whether they want to go on with the measurement or not.  

The option Log overloads in file allows overloads to be recorded. Any occurring overloads 

are documented in text files with the name „*_overload_spectro.txt“ (*-Wildcard for the name 

of the measurement file). 

Measuring process 

If the list of positions contains at least one valid entry, and if there is one valid dark signal 

measurement (depending on the type of spectrometer used, the measurement can be started in 

the group box Measurement by pressing the button Start . In this group box, the estimated 

measuring duration, the start and the end of the measurement, the current spectrometer posi-

tions, the measurement progress (in the form of a progress bar) as well as the status of motion 

of the motors are displayed. A spectrometer measurement can be stopped or continued by 

pressing the buttons Stop and Continue, respectively, or it can be aborted by using the button 

Cancel. 

If a measurement has been cancelled, the result file still re-

mains valid and saves all single measurements which were 

valid up to the moment of cancellation. Immediately after each 

abortion carried out by the user, they are asked whether the 

measuring results shall be deleted or not  

9.3.5 Measuring results 

After completion of the measurement sequence, the results are displayed automatically by the 

tab Results. In addition, measuring sequences can also be loaded, displayed and saved again 

by pressing the buttons Load and Save as … (for data formats see 9.2.3). 

In the left-hand part of the dialog, the measuring data of a single measurement are displayed. 

A single measurement can be selected by means of the scroll bar to the right of the display 

area. 

In the tab Data graph, the data are graphically represented, whereas they are shown in the 

form of a table in the tab Data table (for usage refer to 9.2.3). In the chromaticity diagram 

(tab Chromaticity-graph) the color values calculated from the spectral data are displayed. On 

the right side of the dialog various additional information and calculated values of the spectral 

measurement (e.g. color coordinates, CRI) are listed for each individual measurement. 
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The chromaticity diagram provides various ways of data representation via the context menu. 

The color values for the 2 or 10 degrees standard observer can be calculated (menu item ob-

server) and be represented in different color spaces (menu color space). Zooming of the data 

area is possible by using the mouse wheel. The zoom level can be reset with Zoom reset. 
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By pressing the buttons Actual measurement details or also Common measurement tasks all 

parameters and results of the currently selected single measurement or also of the measuring 

sequence loaded can be displayed. 

9.3.6 Structure of the CSV data file 

The CSV data file of a spectrometer measurement is stored parallel to the TSD file and can, 

for example, be opened with common spreadsheet programs (if necessary, adjust delimiter to 

semicolon). The structure of the CSV file reflects the hierarchical XML structure of the TSD 

file. There are general basic information, information on the total measurement, and finally, in 

columns sorted, the data of the individual measurements. Below substantial extracts from the 

structure are explained. 

Basic information 

These details include information about the software driver and the device. The information 

regarding the wavelength and linearity calibration and the dark signal correction are irrelevant 

for the spectrometers from JETI (Specbos1211) used for RiGO801 goniophotometers. 

 

General information about measurement -> spectral range 

 

General information about measurement -> Measuring results 

 

If measuring values exist that are derived from the complete sequence of spectral power dis-

tributions, these are listed here. Currently, these are only the averages values according to 

LM-79-08 or EN 13032-4. The flag Conformity to … indicates whether these data are availa-
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ble (see 9.3.2) and in this case a list of these values follows. At the end of the file the underly-

ing mean SPD is also output. 

Single measurements -> Measurement settings 

In this branch, the spectrometer settings for each individual measurement are output. 

 

Single measurements -> Additional information 

This branch includes some relevant information about the individual measurements, such as 

axis positions and color values. 

 

Single measurements -> Measurement 

Here, finally, the spectral radiance, the measurement times and modulations of the measure-

ments are given. 
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10 Other program features 

10.1 Data-IO 

10.1.1 LID – export 

The RiGO801 software is well able to output the luminous intensity distribution available in 

the TTL – format in various file formats. Beside the common LID file formats there are also 

export filters available for calculating illuminance distributions or transformations of the LID. 

This export function can be activated 

during the parameterization of the 

measurement (see 6.1.3), or it can be 

called subsequently via the menu item 

File > Lid export …. In the latter case, 

the following dialog is displayed.  

Export format Ascii 

The Ascii-export format is a universal ASCII – for-

mat containing the entries made in the ttl-file in a 

text-readable form (e.g. import to spreadsheet pro-

gram). The luminous intensity matrix (lines: theta, 

columns: phi, first line: phi angle, first column: theta 

angle) is output only for the measured angular range 

and in absolute luminous intensities. 

  

Export format IES 

The IES-format stands as a synonym for a number of downward-compatible formats accord-

ing to the North American standard LM-63 for photometric data and information linked to 

them. 

  

In the tab LID settings optimal smoothing as well as a modification of the measuring grid can 

be set. 

In the tab IES Options the format specifications can be set in the combo box Format , and 

using the selection box Rotate 90° the rotation of the C-planes by 90° can be set according to 

the luminaire alignment following the Anglo-American standard. 
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Export format LDT (Eulumdat) 

EULUMDAT is a format for exchanging photometric data for the luminous intensity distribu-

tion of light sources dating from the year 1990. The typical file extension is *.ldt. In continen-

tal Europe, the format has become the industrial standard for transmitting photometric data. 

Here, the LID values are contained as cd/klm – standardized values without decimals. As the 

format is not applicable to test lamps but to luminaires only, the test lamps contained in the 

ttl-file are summed up to a lamp mount by the summation of the luminous flux. If no test lamp 

is available (number of test lamps is 0 or total luminous flux is 0), a virtual lamp ‚test lamp‘ 

with a measured luminous flux equal to the luminous flux of the luminaire is specified (light 

output ratio of the luminaire 100%). 

Analogous to the export format IES, an optional smoothing and also an optional modification 

of the measuring grid can be set in the tab LID settings. 

Illuminance distribution on a plane surface (*.pf) 

With this export filter the illuminance distribution on a plane surface can be calculated. The 

output format is a floating point image in TechnoTeam .pf - format that can be analyzed with 

the software LMK LabSoft. The positions and orientations of the light intensity distribution 

and the calculation of plane with respect to the world coordinate system can be freely defined. 

The explanation of the functions is carried out below in the example of the calculation of a 

illuminance distribution in the passenger compartment of a car. In this example, due to the 

short distance between lamp and calculation plane, a near-field LID has been calculated from 

the ray data (refer to Software manual Converter801). 

The export filter defines three coordinate systems. The basis is the world coordinate system 

Xw/Yw/Zw. Furthermore, there are the DUT coordinate system (XL/YL/ZL) and the plane coor-

dinate system (XP/YP/ZP), which are positioned with respect to the world coordinate system. 

In this example, the world coordinate system is as-

sumed in the middle of the passenger compartment. 

The reading lamp (DUT coordinate system is posi-

tioned at XW = -600 mm and ZW = 800 mm. The 

orientation of the light doesn’t need to be changed, 

since the measurement has already taken place in the 

installation orientation. The calculation plane for the 

illuminance distribution is set to XW = -600 mm, YW 

= 0 mm and ZW = 0 mm with the size of 1000 mm x 

1600 mm and the resolution of 0.5 px/mm. 
 

The parameters are entered under Settings in the projection settings tab. Depending on the 

preferred approach of the rotation parameters the rotation order can be selected between x-y-z 

and z-y-x. 
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Projection settings Result image of the illuminance distribution with 
isolux lines 

In the single value calculation tab, a list of coordinates (format LabSoft position list) can be 

indicated where the corresponding illuminance levels are taken and written to a separate text 

file. For the evaluation of the illuminance image (TechnoTeam .pf - Format) the software 

LMK LabSoft is necessary. 

Luminous intensity distribution map (*.pf) 

This export filter generates the matrix of the luminous 

intensity distribution as floating point image in the 

TechnoTeam .pf format. The LID can be freely rotated 

in three directions. As coordinate systems are A - and C 

– type available. 

One application is, for example, the projection of the 

LID of a headlamp in A - coordinates. In the following 

example, a reading light has been aligned to the pole 

and measured in the C - plane coordinate system. 

 

However, the usual alignment of headlamps in an A – type measurement is to the equator. 

The rotation of the pole oriented DUT about 90° around the Y axis brings it to this equator 

orientation. The result of this typical headlamp distribution map in A - coordinates is shown 

below. 



Software manual RiGO801 

 

 

21.01.2016 TechnoTeam Bildverarbeitung GmbH Ilmenau 57 / 65 
 
 

 

LID in Type-A coordinates as image 

10.1.2 Loading a result file 

Via the menu item File > Open… luminous intensity distributions (*.ttl) and ray files (*.ttr) 

can be read (see 7). 

10.2 Single access to the hardware components 

Via the menu item Hardware the single controllable components of the goniophotometer can 

be accessed. This is helpful for certain setting and adjustment work as, for example, for set-

ting the optionally incorporated measuring instruments, for the offset-measurement of the 

photometer, or when the goniometer shall be moved to a well-defined position. However, 

accessing the hardware components individually is not necessary for carrying out general 

measuring operations. 

10.2.1 Camera 
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Via the menu item Hardware > Camera… the dialog Camera control is opened. This dialog 

contains only those basic components which are relevant for the image display. They are de-

scribed in detail in the paragraphs 5 and 6.3.  

By pressing the button Close the dialog is closed. 

10.2.2 Goniometer (Motor control) 

After choosing the menu item Hardware > Goniometer… 

the dialog Motor control is opened.  

The upper section of the dialog contains an own tab for 

each of the available axes.  

In the lower section, the current position of the goniometer 

is shown. 

A motor destined for control is selected by clicking with 

the mouse on the corresponding tab. 

By using the buttons Init, the current axis or also all axes 

are initialized and moved to the parking position(s). Nor-

mally, this is not necessary here as all axes have already 

been initialized at program startup. 

The speed is selected in the box Speed. It is indicated in per cent and relates to the maximum 

speed fixed for this motor. A change of the speed only relates to any positioning made in this 

dialog and, thus, does not influence the measuring speed. 

In the box Target the desired position can be entered. After pressing the button  or by 

pressing the Return key, the desired position is approached. 

By pressing the Stop buttons, the current axis or all axes are stopped immediately.  

These two buttons  and  are used to move the device freely in both directions. By 

pressing the button  the motor moves in the direction of some smaller positions, by 

pressing the button  it moves in the opposite direction. Movement stops automatically 

when releasing the left-hand mouse button or also when the end positions in the respective 

direction have been reached. 

 Sensor selection 

The goniometer positions displayed always relate to the sensor selected in the combo box. 

Depending on the mounting position of the sensor on the camera arm of the goniometer, a 

position offset is added to the position of the camera. Camera, photometer and spectrometer 

are available as sensors depending on the respective device configuration.  

By pressing the button Close dialog the dialog can be closed.  

10.2.3 Photometer 

After choosing the menu item Hardware > Photometer… the dialog Photometer settings is 

opened. The first tab - Settings – shows the control dialog of the photometer as described in a 

similar way in paragraph 6.4. The second tab - Calibration - contains the function for the dark 

offset measurement in all measuring ranges.  

The measurement of the offset values is necessary only in the case of some older photometers 

of the type TechnoTeam-DigiPhot3 if the room temperature changes greatly or if very tightly 

radiating luminaires shall be measured. For the offset measurement, the photometer must 
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warm up for at least 0:30h. The photometer head is covered light-proof with a cap, and the 

offset measurement is started by pressing the button Start. 

  

After confirming the concluding message, the offset values determined are then saved in the 

configuration file. Afterwards, all measuring ranges must show a value near or around 0. 

10.2.4 Spectrometer 

The optional spectrometer is described in detail in section 8. 

10.2.5 Measuring instruments 

The external measuring instruments and everything which is connected with them are dealt 

with in detail in section 6.5. If – on program startup – an error message is displayed during the 

initialization of an external measuring instrument, the user may try via this dialog to adapt the 

settings of the instrument concerned. A typically occurring error results from connection 

problems due to modified interfaces. 

10.3 Program errors 

 

Although the software has been developed with great care, errors can never be completely 

excluded. Whenever the user detects an error occurring during work with the program, a mes-

sage should be given to the developers including all available information which could be 

connected with this error. In the case of a program crash or malfunction or faulty measure-
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ment values, it is very helpful to know the last entries, measurement parameters and the pro-

gram behavior immediately before the error has occurred. 

In some cases, an error is detected within the program itself. If this error cannot be removed 

automatically, in general an error window is opened which contains all parameters determined 

by the program. Even if the actual cause of error can possibly not be displayed, the infor-

mation shown can supply some valuable hints. 

In the following example, the cause of error was that the photometer was not supplied with 

electric current. Therefore, it was not possible for the program to communicate with it during 

program startup. 

All messages displayed are saved in a file. The file name can be found in the line Error 

file of the text displayed in the error window. In this particular case, this file contained the 

following information: 

E 0x9000000 0x3bc TSerialPhotometerBasic.cpp(145) Error while transmitting 

the command d 

T 0x9000000 0x3bc TSerialPhotometerBasic.cpp(186)  

T 0x9000000 0x3bc TSerialPhotometerBasic.cpp(186)  

T 0x9000000 0x3bc TSerialPhotometerBasic.cpp(496) Error in the command: 

Setting the input channel 

T 0x9000000 0x3bc TSerialPhotometerBasic.cpp(91) Error in making the first 

photometer connection. Are the interface settings correct? 

T 0x9000000 0x3bc THardware.cpp(507)  

T 0x9000000 0x3bc THardware.cpp(314)  

T 0x9000000 0x3bc THardware.cpp(81)  

T 0x9000000 0x3bc TRigo801Form.cpp(172) 

This exact error description can also be copied into the clipboard by pressing the button Ins 

Clipboard . 

In the case of serious errors such as failed access to hardware components, it is not recom-

mendable to go on with the program. It can then be aborted immediately by pressing the but-

ton Abort program. In the case of some simple errors such as file access errors, the continua-

tion of the program is uncritical. When in doubt or if further errors occur, the software should 

be restarted. 

10.4 Program directories and calibration files 

All RiGO801 program files are copied into that directory specified in the installation proce-

dure (e.g. C:\Programs\TechnoTeam\Rigo801 of June 6, 2011). Furthermore, the following 

subdirectories are created: 

.\Work In this directory, the error files are saved. During each program startup, a new 

file is generated. The program name is automatically composed of the date 

and the time. Error files which are older than 6 days are deleted during pro-

gram startup. 

.\Rigo-

[Projektname] 

This directory contains all files which are necessary for the proper operation 

of the program. Apart from the exceptional cases specified below, no manual 

modifications should be made to these files.  
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11 File formats Rigo801 

The Rigo801 software allows the generation of various result files in each measurement such 

as: 

 The luminous intensity distribution file (file extension *.ttl, as TechnoTeam Luminous 

intensity distribution). This file is generated during each measurement, irrespective of 

whether it is made with the camera or with the photometer. 

 The ray data file (file extension *.ttr, as TechnoTeam Rays). The ray data file is output 

only at the user’s request in the case of measurements made with the camera.  

In the case of measurements made with the spectrometer, the following result files are gener-

ated: 

 The binary TechnoTeam-spectral ray data file (file extension *.tsd, as TechnoTeam Spec-

tral data). 

 Additionally, also the *.csv – format (csv - Comma-Separated Values) as well as the *.isd-

format (isd – Instrument Systems Data) are exported.  

11.1 Luminous intensity distribution *.ttl 

This file is a text file available in the Windows INI format, i.e., the file is subdivided into sec-

tions each of which can contain several entries. The sections can come in any order, for ex-

ample: 

[Measurement] 

Type=Camera 

Rays=Yes 

 

[Files] 

Lid=C:\tmp\test.ttl 

Rays=C:\tmp\test.ttr 

The general parameters provided in the form of lists for display or processing are fixed via a 

description file (template.ini). The first tab Information on measurement of the display of the 

measurement results (see 6.6) is the user interface to these parameters. If an extension of the 

entries is desired, please get into contact with us. 

The TTL – format contains a lot of additional information which is not provided in other for-

mats for luminous intensity distributions. Therefore, the TechnoTeam LID – export filter (see 

6.1.3) and the evaluation program LUMCat of the Czibula & Grundmann engineering GbR 

company extract only part of the information contained. The file format has an open layout. If 

a user wants to create or also adapt their own evaluation software, the following format de-

scription will serve as a basis. 

In the following, only the most important sections are mentioned. In the second column, it is 

specified whether the information given by the user can be edited in the dialog (D), or wheth-

er it is generated automatically by the program (A), and whether it is used in LUMCat (L). 

Section  Content and meaning 

[General] DA

L 

Contains the entry Log number. The measurements are consecutively 

numbered automatically. 

Contains the entry Date. Number of days since 30 December 1899 as 

floating-point number. 
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Contains the entry Time. Given as floating-point number (as a fraction of 

24 h). 

The entry Editor contains the name of the person making the measure-

ment in the form of an ASCII-string. 

In the entry Commentary also multi-line commentaries can be made. The 

desired line breaks must be replaced by „\n“. 

[Luminaire] DL The entries Type and Number contain the strings which can be entered 

by the user. 

[Lamp] DL The entry Number contains the number of the lamps used. 

For each lamp, Type and Number of the lamp can be entered. Both en-

tries are treated as ASCII-strings. 

Further entries for each lamp relate to Power and (current) luminous 

flux. These entries are regarded as floating-point numbers. 

[Parameters] DL Parameters that can be indicated are Laboratory temperature, voltage, 

current, power. 

[LID] AL This section contains the luminous flux measured by the photometer as 

well as the number Mc of the C-planes, their angle distance Dc, the num-

ber Ng of the luminous intensities for each C-plane and their angle dis-

tance Dg. 

[LID/C] AL Contains a list of the angles of the C-planes. 

[LID/G] AL Contains a list of the angles of the luminous intensities for each C-plane. 

[LID/Data] AL The calculation of absolute and standardized luminous intensity values 

from the values indicated here is explained in the following paragraph.  

[Measurement] A General information on the measuring method chosen. 

[Files] A Contains the original file names of the result files. 

[Track of move-

ment] 

A Contains information on the positions approached by the goniometer dur-

ing the measurement. 

[Lens] A Information on the measuring lens used. 

[Camera] A Information on the integration time and the neutral density filters used. 

[Photometer]  Measuring range of the photometer. 

[Rays] A Number of the camera images used and of the rays generated. 

[PoleMonitoring] A Logging of the illuminances on the pole (see 6.8 and 7.8). 

For each pole illuminance, the Phi – angles and the time stamps are saved. 

The values are indicated in each case in the variables PoleVal (lx), Phi (°) 

and Time (DateTime – format, number of days since 30 December 1899 

in the form of floating-point numbers as vectors with the length Count 

(number of scans).  

[PoleMonitoring] 

Count=360 

Time=41324.718620 41324.719016 … 

Phi= 0   0,5  … 

PoleVal=303.88   304.07   303.95 … 

[BurnIn] A Data logged during the burn-in phase of the object to be measured (see 

6.9 and 7.7). 

The first two variables AxisThetaPos and AxisPhiPos indicate the angu-
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lar position of the goniometer during the burn-in phase in [°]. The follow-

ing 4 variables - MinBurnInTimeS, MaxBurnInTimeS, CritIntervalS and 

CritValuePcnt – correspond to the information contained in the dialog 

field Parameter. The other variables contain data relating to the progress 

of the burn-in procedure. 

The variable ResultData contains the illuminances [lx], the standard de-

viations and the error value [%] (variation in the time interval). As the 

separator ‚|‘ is used. The timeline can be calculated from the information 

BurnInStartTime and BurnInTimeIntervalMs [msec]. 

If the logging of the measurement data recorded by external measuring 

instruments is activated (see 6.5 and 7.6), these data are also logged dur-

ing the burn-in procedure. Then, the data are stored in the section 

[BurnInOcxData] (refer to the description concerning section [OCX-

MeasureDevicesData]). 

[BurnIn] 

AxisThetaPos=1.800140e+02 

AxisPhiPos=1.000000e-02 

MinBurnInTimeS=3600 

MaxBurnInTimeS=3600 

CritIntervalS=120 

CritValuePcnt=2.000000e-01 

PartOfMeas=1 

GraphicFileName= 

BurnInTimeS=3.600000e+03 # real burn in time [sec] 

# time distance of m.values 

BurnInTimeIntervalMs=6.000000e+03 

CritFulFilled=0 # burn-in criterion fulfilled y/n 

IlluOverflow=0 # photometer value overload y/n 

MeasContinued=1 # measurement after burn in y/n 

# start time, format see polemonitoring 

BurnInStartTime=4.126147e+04 

ResultData=5.481e+02 3.964e-02 0.000|5.480e+02 3.335e-

02 0.000|… 

[OCX-

MeasureDevic-

esData] 

A This section contains the measurement data of external measuring instru-

ments logged during the measurement (see 6.5 and 7.6). 

The number of measuring instruments is indicated in the section [OCX-

MeasureDevicesData] with the variable Number . 

For each measuring instrument, there is an own section available [OCX-

MeasureDevicesData/DeviceN] (Index N). The variable NumberResults 

indicates the number of the measuring channels included (measured quan-

tities), and NumberData indicates the number of the measured data 

(length of the data vectors). The names of the measuring channels are 

saved in the variables ResultNameN. 

The measured data vectors for each channel are stored in the variables DN 

(Index N, separator ‚|‘). At the beginning, the Phi - position [°] and the 

time stamp [DateTime – format] are shown followed by the measurement 

values of the respective channel. 

[OCXMeasureDevicesData/Device0] 

Name=Power Analyzer WT210 

NumberResults=5 

ResultName0=Voltage (V) 

ResultName1=Current (A) 

ResultName2=Power (W) 

ResultName3=Power factor (PF) 
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ResultName4=Input voltage frequency (V Hz) 

NumberData=601 

D0=150.00|41316.742218|2.955000e+01|5.790000e+00|1.711

000e+02| 1.000000e+00|0.000000e+00 

 A In the case of a measurement made with the camera, the illuminance dis-

tribution measured by the photometer is saved in the same format as the 

luminous intensity matrix in the section [Lvk/Photodata]. Depending on 

the far-field constellation of the photometer, this distribution differs from 

the luminous intensity distribution more or less strongly. However, it can 

be used as a comparison to the luminous intensity distribution if, for ex-

ample, some undefined structures turn up (e.g. unstable light source). 

11.1.1 Calculation of absolute and standardized luminous intensities from the 
TTL – file 

If the direct evaluation of the TTL – measurement file is of interest, absolute luminous inten-

sity values can be calculated from the values contained in the TTL – file by applying the fol-

lowing equation: 

lm
II

gemessen

TTLabsolut
1000


 . 

For the standardization to 1000 lm test lamp luminous flux (cd/klm), the total luminous flux of the test 

lamps from the section [Lamp] must also be taken into account: 


i

lampeilampen , 

lampen

gemessen

TTL

lampen

absolutklmcd I
lm

II







1000

/
. 

11.2 Ray file *.ttr 

During the measurement of the luminous intensity distribution with the measuring camera, 

images are continually captured. Then, rays are calculated from these captures. Already dur-

ing image capture, a luminous intensity distribution is automatically calculated from these 

rays, and written into a luminous intensity distribution file (file extension *.ttl) after the com-

pletion of the measurements. 

Furthermore, the rays generated can also be saved in a ray file (file extension *.ttr). A descrip-

tion of the file format is contained in the Manual on the software „Converter801“. 
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